
Fieldglass Training  

for Suppliers (Open Scope) 

Fieldglass User Account Navigation and Management 

Introduction 

This Job aid explains how to navigate through the Fieldglass application and manage your user account.  

1. Navigation 

2. Your user username is located in the top right hand corner of the Fieldglass page. Click your username to change personal 

options or to customize options. 

 

3. The Home page (or Fieldglass desktop) is your starting point within Fieldglass. Click the Home menu at any time to return to 

the Fieldglass desktop. 

 

4. Use the View menu to locate and view items such as Payments, Workers, and other info. 

 

5. Use the Analytics icon to view or create Reports. 

 

6. Use the Work Items menu to display a list of current items that require your action in Fieldglass. The number above Work 

Items represents the number of actions pending your response. Click the Work Items menu to view all active work items for 

your user account. Work items can include Rejected Fees, Rejected Credit/Debit or SOW Revisions. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Use the Message Center icon to view a list of messages that have been sent to you. Messages opens the message center. 

For more information on the Message Center, please see the Message Center section on page 19. 

 

8. Use the Admin Icon to open the Admin page where you will find links to various administrator settings, such as Password 

policy and User roles. You must have administrator rights to make changes to these settings. 

 

9. Use the Help icon to access Online Help, Release notes, and Reference Libraries. The Help menu also lets you view contact 

information for support and the Fieldglass application version. 

 

10. The SOWs button will be where you will access all active Statements of Work against which fees will be submitted for 

review and approval for work performed. 

 

11. The Starred Items button will be where you access all items you marked with a star. This will let you have quick access to 

any SOWs, Credit/Debit Memos, and other items you want to keep track of. For more information on displaying Starred Items 

on your home page, please see the Customizing your Home Page section on page 8. 
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Introduction 

Fieldglass is organized by modules. Modules are groups of related items or transactions. For example, SOWs and Invoices are two 

modules within the Fieldglass application. 

 

Every transaction within a module is assigned a unique ID number for tracking. For example, when an SOW is created, it is assigned a 

unique ID number. Fieldglass uses a consistent convention for assigning ID numbers. 

ID Naming Convention 

ID numbers are comprised of three separate 

components: 

 

 

 

 

 

1. The Company Code is CN’s ID. 

 

2. The module reference indicates the type of 

item. For example, TQ is used for a Statement 

of Work and CD for Credit/Debit Memo. 

 

 For more information on Module References, 

please refer to the table on this page. 

 

3. The 8 digit consecutive number is a unique 

number that is assigned sequentially by the 

fieldglass application. 

 

The table lists the module reference codes that are 

used by CN within Fieldglass. 

Module Reference Codes 

Reference Code Module 

TQ Statement of Work 

CD Credit/Debit Memo 

TU Statement of Work Fee 

PE Statement of Work Event 

PC Statement of Work Credit Demo 

PI Statement of Work Invoice 

Company Code 

Module 

Reference 8 Digit Consecutive Number 
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Understanding the ID naming convention will help you easily locate the items you are looking for. In addition, when you contact the 

Fieldglass Helpdesk for support, you will be asked for the ID number of the item you need assistance with. 

2. ID Naming Convention 
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To change your Fieldglass application Password: 

  

1. Click your username in the top right and 

select My Profile. 

 

 The Personal Settings page opens, with 

the My Profile tab displayed. 

 

2. Click the Change Password link in the 

Account Information section. 

 

 

 

3. In the Current Password field, enter the 

password you used to log in. 

 

4. In the New Password field, enter your new 

password. 

 

5. In the Confirm Password field, enter your 

new password again. 

 

6. Click Change.  

3. Changing your Password 

1. Introduction 

Editing your profile is a quick and easy way to update your account information. 
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2. Section Overview 

In this section you will learn to: 

• Change your Password 

• Use the Message Center 

• Update Email and Contact Information 

• Update your profile settings 

• Customize your Home Page 

• Add or change Proxy Information 

Managing your Account 
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Introduction 

The Fieldglass application sends messages to users notifying them when there are items requiring their attention. For example, you may 

receive a message when a Statement of Work has been submitted by CN or a fee has been rejected. 

Viewing Messages 

To view messages in the Message Center: 

  

1. Click the Message Center (         ) icon in the upper-right corner of the Fieldglass page. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. At any time, you can filter the messages displayed in your message center by changing the preferences on the left side of the 

page (Notifications, Alerts, Broadcasts, etc.). 

 

• Subject. Enter a word or phrase that appears in the Subject of the messages you want to view to filter the list. 

 

• Message Type. Select the check box(es) for the message types you want to view. These types include Alerts, Notifications, 

and Starred. To view all message types, click Select All. To hide all messages, except for Alerts, from your Message Center 

list, click Select None. 

 

 

 

• Message Status. Select the Unread check box to display messages you have not read. Select the Read check box to display 

messages you have read. 

Note: Because Alerts may be time sensitive, you cannot remove Alert messages from the Message Center. 
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4. Message Center 
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3. Click Filter Messages to apply the settings based on your previous selections. 

 

4. Click the column headers to further sort the messages by Type, Sender (From), Subject and Date Received. 

 

5. To delete a message from your Message Center, select the check box next to the message in the Message Center list and click 

Remove Selected. The message is permanently removed from your Message Center. 

 

6. To view a message, click the message in the Message Center list. 

 

a. If a message includes a link that takes you to the associated document (a Go to Source), you can click the link to display 

the source of the message. 

 

7. When you finished viewing a message, you can: 

 

b. Click Remove Message to remove the message from your Message Center. 

 

c. Click Next to view the next message in the Message Center list. 

 

d. Click Back to Messages to return to the Message Center list. 

b c 

d 
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To update email and contact information: 

 

 

 

 

  

 

 

 

 

 

1. Click your username in the top right and 

select My Profile. 

 

 The Personal Settings page opens, with 

the My Profile tab displayed. 

 

2. Click the Edit button to the right of 

where your name is displayed. 

 

 The My Profile page opens. 

 

3. In the Email field, enter the email address 

where all your email notifications in the 

Fieldglass application will be sent. 

 

4. If you want all notifications to be sent to 

other recipients in addition to yourself, 

please enter their email addresses in the 

Cc: Email Addresses field. 

 

 To enter multiple cc: email addresses, 

separate each address with a comma or 

semicolon. 

 

 

 

 

5. Click Update to save your changes.  

5. Updating Email and Contact Information 

You can change your contact, including your email address at any time. You can also set up a list of email addresses to be included in 

the “cc:” field of all email notifications sent to you from the Fieldglass application.  
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Note: You will have to manually remove the 

emails from the CC; email addresses when you 

want to stop notifications being sent to them. 
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To change your preferences: 

 

1. Click your username in the top right and 

select My Preferences. 

 

 The Personal Settings page opens, with 

the My Preference tab displayed. 

 

2. In the Messaging section, click Edit. 

 

3. On the My Preferences - Messaging 

page, you may indicate whether you 

want Notification, Work Item, Alert, 

Broadcast, Chat, or Starred messages 

sent to your email address. Messages 

generated by the Fieldglass application 

are always available in the Fieldglass 

Message Center. However, for each type 

of item, you can specify if emails should 

be sent. 

 

4. Click Update. 

6. Setting and Changing User Profile Preferences 

The My Preferences tab on the Personal Settings page allows you to change or update your contact information and select how you 

want your notifications, work items, and broadcasts to be routed to you. You can also update your time zone, language defaults, 

number, date and time formatting. 
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Note: If email notifications are enabled, 

messages will be marked as Read in the 

Fieldglass message center. 
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To customize your home page: 

 

 

 

 

  

 

 

 

 

 

1. Click your username in the top right and 

select My Preferences. 

 

 The Personal Settings page opens, with 

the My Preferences tab displayed. 

7. Customizing your Home Page 

You can customize your home page to display only the items counts and charts you want. This can include Starred Items, Notes, 

Announcements and Workers. 
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3. In My Preference page, check or uncheck the items you want to display or remove from your home page. 

 

4. When you have finished, click Update to save your changes.  

2. Click the Edit button in the Home and Detail Page section. 

 

 The My Preference page opens. 
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To Set Up and Manage your Proxy Account: 

 

1. Click your username in the top right and 

select My Profile in the menu that 

appears. 

 

 The Personal Settings page opens, with 

the My Profile tab displayed. 

 

2. In the Proxies section, click Edit. 

 

 The My Profile page is displayed. 

 

3. To add a new proxy, click Add Proxy. 

 

4. Under Work Items, select All to allow the 

proxy to act on all your work items. 

 

5. In the Proxy list, select the person you 

want to add as proxy. 

 

6. Click the calendar icons next to the Start 

Date and End Date fields to establish the 

time period. If you leave the Start Date 

blank, the person selected will become 

your proxy as soon as you select Add. If 

you leave the End Date blank, the person 

will remain your proxy until you remove 

him or her. 

 

7. Click Add. 

8. Setting Up and Managing your Proxy Account 

A proxy account is a great feature you can use to delegate your work items to someone else when you are unavailable. 
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Note: To change the start date or end date for an 

existing proxy, click Edit next to the proxy you 

want to update on the My Profile page. Make the 

necessary changes and click Update. 
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To remove your Proxy Account: 

 

1. To remove an existing proxy, click 

Remove next to the proxy on the My 

Profile: Proxies & Delegates page. 

 

2. Click OK 
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